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Designing with Class -  Using Inkscape  

4th of July Welded Phrase and Mat 
Tutorial Week Three 

Created by Jennie Russ 
Easywishbladers Moderator 

Prerequisites:    

 
Completed Tutorial Week Two  

Purpose of this tutorial:  

 

Learn how to create a good cut file 
Use simplify 
Adding and deleting nodes 
Different node types 
Fixing design issues 
Putting all the steps together and creating a good cut file  

 

Learn how to create mats 
Learn how to add objects to mats to create more dimension/color  

In this tutorial you will learn how to create a good cut file.  You can design all you want to but if you 
can t cut out your design then everything else is wasted.  There are some major differences between 
Inkscape version 0.45 and Inkscape version 0.47 when getting your file ready to cut well.  I refused to 
use version 0.47 because of the changes.  Doing this tutorial finally made me figure out what 0.47 was 
doing and why.  I might start using version 0.47 now.  It is so hard to get used to doing something one 
way and then they go and change things and you have to learn how to do it differently.  I am going to 
cover how to do things in 0.45 and if I have time, I will show you how to do them in 0.47.  

Open up Inkscape by clicking on this icon  

 

and this screen should display:  
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Before we begin this lesson open up your file 4thJuly2010 if it is not open. 
.  To do this click on File menu and select open recent .  Another way to do this is to click on File 

and select Open  and a screen will pop up and you can select the drive and then the folder and then 
the file.  See screen print below:  

  

You should get this file:  

   

To make a better cut file you will need to do the following things: 

 

Reduce your nodes 

 

Get rid of nodes stacked on top of one another 

 

Smooth the nodes  

 

Adjust node handles so they don t overlap 

 

Modify areas where there are unwanted overlaps  

 

Increase the size of the cut so the cutter will not rip the paper  

I always start at the left hand side of my design and slowly work my way around my design using all 
the techniques listed above.  We will learn these various techniques first, before we begin the process 
of creating a better cut file.    

Lesson One   Reduce your nodes by using simplify  
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Step One:  The first thing I want you to do is click on the + key on your keyboard and zoom in so 
you can work on your design.  The minus key -  will zoom out if you zoom too far.  Now you have 
zoomed in on your design so you can work with it better,   

Step Two:  I want you to select your design by clicking the Select tool  and then left mouse click 

on your design.  Then click on the Nodes tool 

 
and your design should look like this:  

 

Step Three:  Now using the Click and drag method, while the nodes are displayed hold down your left 
mouse key and drag a box around the entire design selecting all the nodes.    Your screen should look 
like this now:  

  

Step Four:  Now click on Path menu and select Simplify .  See screen print below:  
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The nodes were decreased substantially.  See screen print below:  

 

Now a decision needs to be made.  Do you like the results that happened when clicking on simplify or 
did it affect the overall design too drastically.  Using Simplify can sometimes distort, or blur, or fade 
the edges of your design.  Let s look at the before and after:  

     

 

Before Simplify                                                                     After Simplify  
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You can see the first one is crisper than the second one.  You can see the O on the word OF got 
distorted and you will have to fix that.  Most of the times I do not use simplify to reduce my nodes 
because of this.  However, this did not turn out too bad.  As a beginner, I recommend trying this 
method.    

Note:  Another way to simplify is --You can just select the design and then click on  Path 
menu and then select Simplify and your design will be simplified.  I showed you these 
extra steps so you could see how drastically the nodes were reduced.  

Lesson Two 

 
deleting and adding nodes yourself  

All throughout this tutorial I have taught you to navigate in Inkscape using the menu and the tool bars.  
In this portion of the tutorial I will be using short cut keys.  My primary reason for this is that this 
process can be tedious and the faster you can do it the better job you will do.  Remember, if you forget 
the short cut keys I teach you, you can always go back to the menu or tool bars displayed below and do 
the same action there.    

    

Before we begin step one in this lesson, click undo (CTRL Z) if you want to try this method instead of 
the simplify method in lesson One, or you can leave the simplify and continue adding or deleting nodes.  

Step One:  To start deleting the nodes, I want you to zoom way in on your design by clicking on the 
+ key on your keyboard.  See screen print below.  For this demonstration, I left the designed 

simplified.  As you can see now that we have zoomed in, the letters are slightly distorted.    

  

Step Two: Starting on the left outer edge of your design we will add a node. Making sure the Nodes 
Tool is selected and your nodes are displaying, Let s add a node.  Using your Left mouse key double 
click where you would like to add a node.    A node should have appeared.  See screen print below.  
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Step Three:  Let s delete a node.  You can see in the picture below when the node got added it was 

highlighted.  

 

  Click off the design on the white space, it will deselect the node.  
Now click back on the node and the node gets highlighted again.  While the node is highlighted now 

click on the Delete key on your key board.  The node was deleted.    This is how easy 
it is to add a node and delete a node.    

Note:  You can use the Backspace key as well as the Delete key to delete nodes.  I 
personally use the Del key on my key pad.  I use this since it is at the bottom of my key 
board and my hand will not touch any other keys while I am working.   

Step Four:  I have clicked on undo  a number of times (Ctrl Z) to get back to my original design right 
before I simplified it.  In this step we are going to use the above techniques of adding and deleting 
nodes in rapid succession.  Go to an area on your design where the nodes are all stacked up on one 
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another like this  .  Hold down the delete  key, and while holding the delete key down 
start clicking on the nodes.  They will disappear or be deleted.  It should start to look like this. 

.  Another method is to click and drag around multiple nodes like this.

 

and then when you see them highlighted 

 

then click the delete key.  Using these two 
methods, you will be able to get rid of a lot of nodes in a short period of time.  

I like using this method for getting rid of stacked nodes .  When you see stacked 
nodes there could be as many as two to seven nodes all stacked on top of another.  This is what causes 
your design not to cut out good.  You must get rid of these issues.   

Lesson Three:  Learning the different node types  

The two node types we are going to discuss in this lesson are the corner node type  and the 

smooth   node type.  Your design will cut out much better if you convert most of your nodes to a 
smooth node.  Think of your blade on your machine as a little car that is moving along a road which is 

the path of your design.  When your car comes to an intersection it has to stop and then make a 90 
degree turn.  This is what your blade does when it meets a corner node.  I t stops, and on my machine 
lifts up and adjusts the blade to the new direction and goes right back down into the same spot but 
pointing in the new direction.  After your design is cut you will see evidence of this because it looks like 
someone stuck a straight pen into your design at that point or intersection.  Now think of your car when 
it goes around a curve in a road.  It has to slow down, but it can continue making the curve without 
having to stop and reposition.  That is what a Smooth node is.  When the cutter encounters a smooth 
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node it will continue along its path without having to reposition the blade.  This is why you want to 

convert most of your 

  
corner

 
nodes to smooth nodes .  There are exceptions to this, but for 

the most part this is what you will want to do.   

Step One:  Zoom in on your design and pick a location on your design where there is an extreme 

corner.  I chose the corner of the 4 .  Do this by clicking on the + key several times.  
Now hold down your Shift key and the S key simultaneously and at the same time select the node 

on the corner of the 4 by left mouse clicking on it.  This changed the node from a corner node   to 

a smooth node          .  (Note:  A corner node is triangular in shape.  Where as the 
smooth node is square in shape).  You can adjust the handles to your personal liking or leave them 

the way they are.  I like a crisper look so I adjusted them to look like this .  As shown in 
the previous picture with the node selected I then clicked on the little circle on the handle and I 
dragged it inward toward the node to make the curve less curvy.  I did the same exact thing on the 
other handle on the other side of the node.  

Another method is to click and drag around multiple nodes   and then click on the 
Shift key and the S key simultaneously and multiple nodes will change to smooth nodes.  In fact you 

can do this to the entire design; however, I do not recommend doing that.  My recommendation is to do 
them in smaller portions of your design.   
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You will use the techniques you learn in lesson One, Two and Three above in conjunction with one 
another to create a good cut file.  So learn how to do each of these techniques before moving on.  

Lesson Four:  Perfecting your design before reducing the nodes  

In this lesson you will take a look at your design and perfect it so that you are happy with it before you 
start reducing nodes and changing them to smooth nodes.  For instance, on this design you might want 
to fix several issues such as  

Issue number One:    and this 

  

The issue here is that the star point should be widened so that a good cut can happen.  If you left it this 
way it will not have enough strength to hold together when separating it from your paper.  It will most 
likely crease or bend or in some cases tear away.  

All you have to do is click on this node and drag it until the star point is double the width it was as 

shown in picture.  

  

Go around your design looking for these kinds of areas and correct them.    

Issue number Two:    

  

See how the line beneath the zero is jagged.  Let s fix that.  With the nodes selected click on this node   
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shown in the picture, highlighting it         

 
and then click on the delete key.   It 

should look like this now.   

  Now click on this node shown in the next picture and drag it until you like what you see 

   Now click on this node shown in the picture and change the node type to 
smooth by clicking on Shift key and S key simultaneously or just click on the Smooth node icon  

  on the bezier tool bar.  Now that the node is smooth adjust the handles until it looks like this  

 .  You have now fixed the issue.     

Issue number three:  Tight areas   

Like this      fixed by moving nodes 
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Issue number Four (Advanced not for beginners):      

See how the J, the U, and the L are all welded together.  I personally don t think there is an issue here 
but let s say you don t like the U joined to the J .  This is how you would fix it.  

I would click on this node  

 

and then click on this icon on the bezier tool 

bar  (Break path at selected nodes).  This will break the path.  The node should look like this now. 

.  Now click on this node and drag it and you will see that there are two nodes now.  

  You will see that there is a break between the two nodes if you go into Outline view by 
clicking on the View menu and selecting Display and then selecting outline .   See picture shown.  
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Staying in outline view click on this node  

 

and then click on Delete key to 
delete the node.    

Now click on this node    and then click on this icon on the bezier tool bar 

 

(Break path at selected nodes).  This will break the path.  Now drag the node down showing the node 

beneath it.  Now you have two broken segments that you will merge together.    

Now click on this node shown in picture (the red one) along with this node shown in 
picture (the blue one) by clicking one node and then holding down the Shift key while selecting the 
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second node.  This will select both nodes making them both highlighted at the same time.  (Note:  You 
can t use the drag and select method forming a box around them because they are too 
close together with other nodes) .  With both nodes selected, now click on the  (Join selected 
end nodes with a segment) on the bezier tool bar.  It merges the two nodes together with a segment.  

It should look like this now:  

    

Now perform the same process with the other two broken nodes.  Selecting each node and then clicking 
on the  icon (Join selected end nodes with a segment) on the bezier tool bar.  It should look like this 
now:  

  

At this point I would go back into Normal view by clicking on the View menu and then selecting 
Display and then selecting normal .  
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Now click on the various nodes dragging them into positions you would like them to be in.  After you 

have done this your U should look something like this.       Now you can repeat 
these steps on the other side of the U .             

Lesson Five:  PUTTING ALL THESE STEPS TOGETHER TO CREATE A GOOD CUT FILE  

Now you have learned a few of the ways to fix your design and make a good cut.  Making a good cut 
design can be very tedious and time consuming.  However, you will be happy with your results if you 
spend the extra time to do these steps.  Now let s begin doing this on the design.    

1) Reduce the nodes  

Start at the left hand side of the design and work your way around your design deleting the nodes.  In 
areas where you have lots of unwanted nodes, use the click and drag method creating a box around the 

nodes selecting them and then click on the Delete key on the key board as shown 

  

In areas where you need to delete only a few here and there I hold down the Delete key and click on 
the nodes I want to delete moving along the design.  If the design warps or distorts into something I 
don t like I just click the (Ctrl Z) to undo.  Continue this until you re happy with your design.  It should 
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look like this.    There is not one 
node that is not required and there are no nodes that are stacked on top of each other.  A good rule is 
to delete every other node and then go back and do that again.  However the more you do this, then 
the more you will learn what nodes are okay to delete in the first place.  This cannot be taught. You 
learn this by doing it.  

2) Change the node type to Smooth nodes    

Start at the left hand side of the design again and now start changing the node type to Smooth nodes.  
Select the node you want to change making sure it is highlighted and then hold down the Shift key 
and the S key simultaneously.  The node will change to a Smooth node.  Then adjust the handles on 
each side of the node.  After doing this around the four in your design, it should look like this.  

   As you can see the 4 has lost some of its crispness, but it will cut out so 
much better.  A lot of people will skip this process.  I for one never do.  It is up to your personal 
preference.  A rule of thumb is, if you are creating a straight line for a frame, horizon or something like 
a fence post, you probably do not want to smooth the nodes.  In all other cases, you do.  Again, this is 
something you learn by doing it.  It cannot be taught.  When you are done, your design should look 
something like this now.  All unnecessary nodes eliminated and all nodes changed to Smooth nodes.  



 

16

    

Lesson Six:  Learning how to make a Mat  

To make a mat we will be using the outset function in Inkscape.  Yes, you can do this using dynamic 
outset or even linked outset .  In Inkscape there are many ways to do the same thing.  There are 
usually pros and cons to doing them one way or the other.  I am showing you what some people might 
think is the long way but in reality it is the fast way.  I f you use dynamic outset you can create the 
mat in less steps however it creates it with so many nodes that in reality it takes you longer since you 
are going to have to delete most of the nodes it creates.  

Step One:  In this step we are going to make a copy of your design.   Select your design by clicking on 
it or hitting the Select tool and then clicking on it.  With your design selected (highlighted showing a 
dashed box with the arrows showing around it).  Now click on Ctrl C on your key board.  You do this 
by holding down the Ctrl

 

key and then simultaneously holding down the C key.  This will copy your 
design and place it in the clipboard memory of your computer.  Now move to a location on your screen 
where you would like to have the new copy of your design show up.  Now click on Ctrl V on your key 
board just like you did when you selected Ctrl C .  This will copy the image stored in your clipboard 
memory to your location on your screen.  You should now have a copy of your design.  

Step Two:  Now select the copy you just made again making sure the copy is highlighted with a 
dashed box and arrows showing up around it.  See image below:  
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Now click on Path menu and then select Outset .  See image below.  

  

Repeat the steps in step two, 2-3 times making the mat the size you want it.  (You will click on Path 
and select outset 2-3 times).  It should look like this.  
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Step Three:  In this step we want to maintain the spaces/holes that are between the words so that the 
phrase is easier to read.  Select your mat and now with you mat selected go down to your palette on 
the bottom of your screen and click on the navy blue square and drag it and drop it onto your mat.  It 
will change the color of the mat to blue.  If your palette is not showing, then just right mouse click and 
then select fill/stroke and then the fill/stroke window will appear and select the navy blue color that 
way.  (Note:  To set your palette to display refer to my instructions I sent earlier) .  

Now that your mat is a different color left mouse click on the mat design and drag it on top of the 

original design.  With it still selected, click on the  icon at the top of your screen.  See picture 
below.  

  

Your screen should look like this now. 

See the space between the F and the J .  We should 
make this bigger so the phrase can be read easier.  Once we do this, we can then delete the holes in 
the mat we don t want.   

With the Nodes tool selected zoom into your design.  Click on the blue portion/ the mat and you will 
see the nodes for the mat display.  Click on the Red portion and you will see the nodes for the original 
design display.  Since you want to move the nodes and form the hole bigger on your mat, click on the 
blue mat.  Now using the techniques you learned earlier such as dragging nodes, adding nodes, deleting 
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nodes and making nodes smooth, make the hole the shape you think it should be.  
Your new expanded hole should look something like this.  

   

Step Four:  In this step we are going to get rid of unwanted holes in our mat.  Click on the mat and 
drag the mat to just beneath the original design so you can get rid of the extra holes you don t want.  
Then click on the Nodes tool making the nodes show up on your design.  Now using the left mouse 
click and drag method, highlight all the nodes forming the first hole you want to get rid of.  With the 
nodes highlighted, now click on the Delete key on your keyboard to delete them.   See image below:  

  Continue doing this for each hole you want to delete.  Your design when finished 
should look like this now.  
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Step Five:  Now make a copy of the blue mat so that you can make the white mat which will be put on 
the bottom layer.  You do this by selecting the blue mat and then clicking on (Ctrl C) and then click on 
(Ctrl V). You should have two blue mats now.  Now select the blue mat you just created and then click 
on one of the grey squares on your palette and drag it and drop it onto the blue mat.  You now should 
have a blue mat and grey mat.  See image below:  

  

Step 6:  In this step you are going to apply outset  to the grey mat to make it larger than the blue 
mat.  We are going to use the same steps we performed in Step two above.  With the grey mat 
selected, click on the Path menu and select outset .  Repeat this 3  4 times.    

Now, just like we did in step three we are going to click on the blue mat and drag it under the red 
original design.  Now we are going to take the grey mat we just created and drag it on top of the 

original red design.  With the grey mat selected click on the lower to bottom icon  to lower the grey 
mat beneath the blue mat.  Your screen should look like this now.  
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Step Seven:  In this step you are going to weld the 6 stars you created in Tutorial Week Two onto the 
blue mat.  Leaving your design layered take your stars and place them around the edges of the blue 
mat to get an idea of where you want them to be located.  See image below.  

  

Now click on the Nodes tool and then click on the blue mat.  You should see the nodes displaying 
along the edge of the blue mat.  I f you don t keep deselecting the nodes by clicking on the white space 
on your page and then trying to select the outer most edge of the blue mat again.  See image below.  
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Once you see the nodes outlining the blue mat, Click on the Select tool and this will select the blue mat.  
Now with the blue mat selected, hold down the Shift key and select each of the six stars.  Now click 
on Path and then select union .  Your blue mat now should have the six stars welded to it.  

Step eight:  Now drag your grey mat to the bottom of the screen.  Then drag the blue mat just 
beneath the red original design.  Now delete any holes in the grey mat that you do not want.  Now 
follow the steps in creating a good cut on the two mats.  You will want to reduce some nodes and 
change the node types on both mats.  I would place the original design on top of each mat when 
making any changes so that you will be sure the outline is maintained.  Your design should now be 
ready to cut out. 


